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SPECTRAN 
USA Addendum 

 
Contained in this addendum are clarifications to the SPECTRAN HF Series Users Guide 

and information on specific USA modifications. 
 
 
 
 
 
Please note that your SPECTRAN HF has been preprogrammed (dependant on models) 
with the following USA Hot Key frequency sweeps.  These sweeps replace the listed Hot 
Keys on page 8 of the Users Guide.  Also note that if “factor” (Factory) is used in the 
Setup mode, all programming will return to the original factory defaults and the Hot Keys 
will have to be reprogrammed. 
 
Numeric Block (Hot Keys) 
 1 = VHF  168MHz – 215MHz 
 2 = UHF 1  450MHz – 699MHz 
 3 = UHF 2  700MHz – 865MHz 
 4 = Wi-Fi  2390GHz – 2450GHz (Wireless LAN) 
 5 = TEL  900 MHz - 930 MHz (Cordless Telephone) 
 6 = BLUE  2450 (Bluetooth) 
 7 = STL  944MHz - 952MHz (Studio Transmitter Link) 
 8 = AVIS  2900GHz - 3260GHz (Automotive Vehicle ID System) 
 9 = ASTLIS  48MHz - 82MHz (Assisted Listening 
 0 = DECT 1885MHz – 1885MHz 
 
Installing the SPECTRAN Driver Software 
DO NOT MANUALLY INSTALL THE DRIVER SOFTWARE… Copy the 
SPECTRAN Driver and LCS Software from the included CD to your desktop.  Plug in a 
USB cable between the SPECTRAN and your PC and then turn on the SPECTRAN.   
 
Windows should recognize that new hardware has been found and will begin to walk you 
through the “Found New Hardware Wizard”.  When the prompt / screen comes up which 
asks whether to Install from a CD or from a specific location, select the “Specific 
Location”.  Use the Browse button on the next screen to navigate to the Kaltman 
Creations SPECTRAN Driver Folder and click “Next”.  On the next screen select 
“Search for the Best Drivers in these Locations”, and check the box for “Include this 
Location in this Search”. Click “Next”.  A warning message may appear stating that the 
software has not passed a Windows Logo test, Select “Continue Anyway”.  The actual 
Driver install will now take place.  
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Installing the LCS Software 
Once the Driver is installed, the Kaltman Creations SPECTRAN LCS software is ready 
to go.  Simply click on the SPECTRAN Icon (LCS_1257E.exe) to launch the program. 
 
Application Note 
The SPECTRAN LCS PC software, which is included with your SPECTRAN unit, 
provides an enhanced visual display and enhanced data capture capabilities.  It is also 
required for most programming functions and firmware updates.  
 
Data Capture / Logging 
The SPECTRAN has capabilities to capture, store, and retrieve data.  The main capture 
functions are: 
 
1). Use the SPECTRAN Data Logging function within the SPECTRAN (memory 
dependant) and then download the data to your PC via the LCS software. (The Spectran, 
as a standalone handheld device, is limited to Peak Marker capture only) 
2). Record & view real-time data on your PC as it is captured directly from the 
SPECTRAN, (no memory limitations). (The Spectran, connected to a PC, allows for 
detailed data capture including date and time stamps) 
3). “Screen Print” your PC sweeps displays. 
4). Run the SPECTRAN with the MAX HOLD function activated for viewing of all 
frequency “hits” (data will be lost on setting changes or power off) 
 
Data Logger Applications Notes: 
For specific details on the setup of the Data Logger, please refer to page 27 of the 
SPECTRAN Users Guide.  Below are some minor notes, clarifications of terms, and 
examples for the setup of the Data Logger within the SPECTRAN HF unit: 
 

♦ Logged data is non-volatile and stays in the SPECTRAN memory location 1000 
until overwritten.   

♦ Logged values will reflect user determined settings such as Peak and Hold 
♦ Changing the settings during a Logging session can distort the results 
♦ 64K of memory is standard.  For extensive data capture, more memory may be 

required.  Please contact Kaltman Creations for upgrade details. 
 
 “Count” is the total number of times the sweep data is captured 
“Time” is the interval, in seconds, between data captures 
“Field” is where the data is stored and Should Always Be at Location 1000. 
(“Count” “Time” and “Field” only apply to data stored directly into the analyzer and not 
for PC logging)  
 
Example 1: 
Count: 60 (this will log 60 separate sweeps) 
Time: 60 (this will allow 60 seconds to pass before another sweep capture is logged) 
 
In other words, there will be 60 separate sweeps each spaced 60 seconds a part (once 
every minute) and therefore will log for an hour. 
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Example 2: 
Count: 1000 
Time: 60 
 
This will log 1000 separate sweeps.  Each sweep is spaced 60 seconds a part and will 
therefore log for 16.66 hours. 
 
Transfer of Logged Data  
(Only for data stored directly into the analyzer, not for PC Logging) 
How to transfer the data from your SPECTRAN HF unit to your PC for file conversion: 
(The SPECTRAN Driver software and SPECTRAN LCS software must be installed.  See 
Driver and Software Installation)   
 
1). Connect the SPECTRAN to your PC via a USB cable. 
2). Initiate / launch the SPECTRAN LCS software. 
3). Use the CONNECT button (upper left-hand corner of the PC screen, located just 
under the word “File”).  This establishes communication between the SPECTRAN HF 
unit and the LCS software.  
4). Under the “Extras” pull-down menu, open File Manager.  The File Manager screen 
will open up. 
5). In the File Manager screen scroll down to the Logger Data file.   
6). Double click on the file titled “Logger Data” and the data will open up as a table.  At 
this point you can simply copy and paste the data into spreadsheet application such as 
Excel for data manipulation, charting, etc. 
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Record Data 
You can view and capture real-time data on your PC as it is read directly from the 
SPECTRAN HF unit. (The SPECTRAN Driver software and SPECTRAN LCS software 
must be installed.  See Driver and Software Installation)   
 
Connect the SPECTRAN to you PC via a USB cable. 
 
Run the LCS software. 
 
Use the Connect button (upper left-hand corner of the PC screen, located just under the 
word “File”).  This establishes communication between the SPECTRAN HF unit and the 
LCS software.  
 
Set up any parameters, i.e. frequency range, bandwidth, levels, etc. This can be 
performed directly on the SPECTRAN handheld or within the SPECTRAN LCS 
software. If you make changes to the parameters after you have started a sweeping 
display, you may have to use the Upload and Download buttons (located between the 
Clip Board and Play button) for one device to recognize the changes to the other.  Re-
clicking on the Connect button will also force the devices to update to the changes. 
 
Use the Play button ► to start the sweep display.   
 
Once the sweep display is initiated, the data is automatically being recorded within the 
PC.  The recorded data includes: Date, Time, Peak Markers, all of the Frequencies in the 
selected range (with data points determined by the RBW) and their associated dbm 
values. 
 
To save the data use the “Save Recording” functions within the “File” pull-down menu.  
Every time you select “Save Recording” all of the data up to that point in time (since the 
start of the session), is saved.   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When you wish to stop recording, use “Save Recording” or “Save Recording As” and 
save the file to your desktop or a folder of your choice.   
 



 5 

 
Recording / Logging Playback 
While it is not possible to actually playback the captured data like a movie, there is a very 
powerful feature that allows you to load the data back into the PC LCS software for 
detailed spectral review.  Simply use the “Load Recording” item under the File pull-down 
and load in a previously saved file.  You will note that the data now appears in the 
waterfall section of the display.  Check the box called “Trace History” located at the 
bottom of the Sweep control panel.  Now, whenever and wherever you place your cursor 
within the time-domain of the waterfall display will produce a spectral image of the 
traces up in the sweep area above.  As you move the cursor forwards and backwards in 
time (up and down through the waterfall display), you will get a detailed re-account of 
the traces.   
 
Additionally, by clicking on an area within the waterfall screen, the traces at that point in 
time will appear and remain visible as a fixed trace on the screen.  This is ideal for trace 
to trace comparisons.  Clicking again will update the fixed on-screen trace.  Clicking on 
the Trace History check box will clear the fixed traces. 
 
To return to normal analyzer use (non-playback of logged data), please be sure to 
uncheck the Trace History box. 
 
Uploading the Raw Data to Excel 
When using spreadsheet software such as Excel or Lotus 123, locate their Import Data 
prompt.  In Excel, the Import External Data function is located under the “Data” pull-
down.   
 
In Excel, import the data as: 
All Files 
Delimited 
Semicolon 
 
Once imported, manipulate and chart the data as needed. 
 
Screen Print 
You can use your computer’s Screen Print function for a very quick snapshot of your 
data.  On most PC Qwerty keyboards, the Insert key (Ins) doubles as a Print Screen 
(PrtSc).  Press your Function Key (FN) and PrtSc at the same time and the current screen 
is saved to your clipboard for pasting into Word, Excel, etc.   
 
Helpful hint: Once pasted in Word you can resize it as needed, or if you want to be able 
to reposition it anywhere on the page, simply double click on the pasted screenshot 
image, a box (Format Picture) will open up, click on “Layout” and then “Advanced” and 
then select “Through”.  This will allow the image to float anywhere on the Word page. 
 
Hot Keys (Renaming & Reassigning via LCS Software) 
(The SPECTRAN Driver software and SPECTRAN LCS software must be installed.  See 
Driver and Software Installation)   
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Connect the SPECTRAN to you PC via a USB cable. 
 
Run the SPECTRAN LCS software. 
 
Turn on the SPECTRAN unit. 
 
Under the “Extras” menu, open the File Manager pull down.  When the screen opens, 
click on the “Connect” box (lower right-hand corner of LCS “Filesystem” screen) and 
you should see the following: 
 

 
Click through each “Taste” (Hot Key Assignments) to view their individual parameters 
and presets.   
 
The USA pre-assigned IDs are as follows: 
 
Numeric Block (Hot Keys) 
 1 = VHF  168MHz – 215MHz 
 2 = UHF 1  450MHz – 699MHz 
 3 = UHF 2  700MHz – 865MHz 
 4 = Wi-Fi  2390GHz – 2450GHz (Wireless LAN) 
 5 = TEL  900 MHz - 930 MHz (Cordless Telephone) 
 6 = BLUE  2450 (Bluetooth) 
 7 = STL  944MHz - 952MHz (Studio Transmitter Link) 
 8 = AVIS  2900GHz - 3260GHz (Automotive Vehicle ID System) 
 9 = ASTLIS  48MHz - 82MHz (Assisted Listening 
 0 = DECT 1885MHz – 1885MHz 
 
Enter any value changes you wish to make.  You can also change the “Printstr 03h” text 
which will change the Hot Keys custom text as it appears on the SPECTRAN HF unit 
LCD display.   The maximum number of characters in the LCD display is 6. 
 
Once you have completed the entries, click “Translate” and then click “Write”.  The word 
“OK” should appear in the description box.  As you move on from one Hot Key 
assignment to the next you may need to click on “Read Again” to update your changes. 

Text Name 
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Hot Keys (Renaming & Reassigning direct entry in SPECTRAN HF) 
For detailed instructions, please refer to page 28 of the SPECTRAN Users Guide. 
 
Hot Key programming can be performed directly on the SPECTRAN (no PC connection) 
but unlike using the SPECTRAN LCS PC software, there are no means of direct text 
entry and the custom naming of Hot Keys.  When setting-up the programming of the Hot 
Keys in this fashion, the assigned Center Frequency value will automatically appear in 
place of a text name on the SPECTRAN display. 
 
Set-up and enter all values and parameters which you ultimately plan on saving as a Hot 
Key.  Go to “SetUp” in the SPECTRAN HF unit’s menu, select “Store” and assign a 
memory location number: 101 – 109 for Hot Keys and 110 up for additional storage 
locations.  The number of additional storage locations may be limited by the amount of 
available memory (64K standard).  Memory upgrades are available when required.   For 
more information on memory upgrades, please contact Kaltman Creations LLC.  
 
Zoom and Cursor feature in the SPECTRAN LCS software 
While viewing a LCS PC sweep or a static display, you can Zoom in & out as desired.  
To Zoom in simply click and drag across the desired frequency range.  To Zoom out, 
simply right-click above the area you wish to expand.  Also, if you right-click on the left 
side of the screen, you Zoom out down the frequency scale.  Right-click on the right side 
of the screen and you Zoom out in the higher end of the scale.  You can right-click 
(Zoom out) all the way back to a full spectrum span (full range of the SPECTRAN HF 
unit) if you wish.  You can also simply single-click (instead of click and drag) on a 
frequency and you will instantly Zoom in on that frequency to its maximum amount. 
 
Cursor & Zoom feature in the SPECTRAN HF unit 
Rotating the Jog Dial on the SPECTRAN HF unit (just enough to activate it), will 
immediately place a cursor bar in the center of the display.  By using the Jog Dial you 
can position the cursor bar anywhere on the display, which will in-turn give you a readout 
of the frequency and associated level at that location.  
 
When clicking on the Jog Dial, the SPECTRAN HF Zooms in at 50% increments 
(narrowing the frequency span each time).  You can repeatably Zoom in all the way to a 
single frequency point, but there is no Zoom out function within the SPECTRAN HF unit 
(there is a Zoom out feature in the LCS software).  To return to the original sweep 
frequency span, simply reload the Hot Key or re-enter the High and Low frequency 
values. 
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Recent Updates (which Do Not appear in the manual) 
 
Contrast control of the display - Hitting the “Enter” key when “Display” is highlighted 
in the menu will allow you to adjust the LCD contract via the jog dial on the side of the 
unit.  When the desired contrast is achieved, hit “Enter” again to accept. 
 
Peak Marker Count display - You can select the number of  Peak Markers to be 
displayed (0, 1, 2, or 3).  Hit the “Enter” key when “MrkCnt” is highlighted in the menu.  
Then enter the number of Peak Markers you wish to be visible on the LCD display and 
then hit “Enter” again to accept.   
 
In the PC LCS software, open the “Spectrogram” control panel (located in the “View 
pull-down menu).  Note towards the bottom of the Spectrogram control panel a location 
where you can enter up to 10 Peak Markers and an associated threshold level setting. 
 
Marker Points – The PC LCS software has a very power feature called Market Points.  It 
allows you to visually keep track of frequency regions or specific signals in the sweep 
display by placing vertical bars within the display.  Each Marker Point bar will list its 
position by frequency and level in dbm and also list the frequency span between Marker 
Points.  To activate the Marker Points, open the “Spectrogram” control panel (located in 
the “View pull-down menu).  Note at the bottom of the Spectrogram control panel a 
check box titled “Manual”.  Checking this box now allows you to click at the very top of 
the sweep display to place a Marker Point.  You can click on an existing Marker Point to 
remove it and you can use the CLEAR button located to the right of the display to clear 
all.  
 
Other Helpful Hints 
 
Remember to hit “Enter” - When entering values into the LCS software (such as Start 
and Stop frequencies, Resolution, etc.) always conclude the entry by hitting the “Enter” 
key.  This will insure that the values changes are accepted. 
 
Quick Freq Span view - When using the Spectran HF unit and you wish to review the 
frequency span you are using, simply hit the Menu button one time and the Peak Markers 
will now indicate the Start, Center and Stop frequency values.  Hit the Menu button again 
and the unit will return to the spectrum sweep mode.  
 
Ghost signals - If you experience what appears to be phantom, ghost signals or aliasing, 
try setting the analyzer RBW to 300KHz. 
 
 

Questions, suggestions and comment are always appreciated.  
For Technical Support Call Kaltman Creations 678-714-2000 (EST) 


